
Patterns are pleasing to the eye.

They are used by designers,

architects, and engineers to make 

their products more attractive.

Look at the quilt pattern.

Which figures are used as 

quilt blocks?

Which other figures have 

you seen in quilts?

What 
You’ll Learn

• Identify, describe, compare,

and classify figures.

• Identify the conditions that make

two figures congruent.

• Construct and analyse tiling patterns.

• Recognize the image of a figure 

after a transformation.

• Create and analyse designs 

using transformations.

Why It’s 
Important
• Geometry is used daily by 

scientists, architects, engineers,

and land developers.

• Geometric attributes, such as

congruence and symmetry, enable 

you to see the world around you 

in a different way.
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Key Words
• convex polygon

• concave polygon

• tiling the plane

• tessellations
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246 UNIT 7: Geometry

Classifying Triangles

Here are two ways to classify triangles.

• By side length

An equilateral triangle An isosceles triangle A scalene triangle 

has all sides equal. has 2 sides equal. has all sides different.

• By angle measure

An acute triangle A right triangle An obtuse triangle 

has all angles less has one 90° angle. has one angle greater

than 90°. than 90°.

Use square dot paper or isometric dot paper.

1. Draw an isosceles triangle.

Is it acute, obtuse, or right? How do you know?

2. Draw an obtuse triangle.

Is it equilateral, scalene, or isosceles? How do you know?

3. Can you draw an obtuse isosceles triangle? 

If you can, draw it.

If you cannot draw the triangle, say why it cannot be drawn.

4. Can you draw a right equilateral triangle?

If you can, draw it.

If you cannot draw the triangle, say why it cannot be drawn.
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Constructing a Triangle 

Here are two ways to construct a triangle, using a ruler, compass, and protractor.

Example 1

Construct �ABC with AB � 4 cm, BC � 6 cm, and CA � 7 cm.

Solution

You will need a ruler and compass.

Step 1 Sketch the triangle.

Step 2 Construct the triangle:

Use a ruler to draw side BC � 6 cm.

With the compass point and pencil 7 cm apart,

put the compass point on C and draw an arc.

All points on this arc are 7 cm from C.

With the compass point and pencil 4 cm apart,

put the compass point on B and draw an arc.

All points on this arc are 4 cm from B.

Make sure the arc intersects the first arc you drew.

Mark a point where the arcs intersect.

This point is 7 cm from C and 4 cm from B.

Label the point A. Join AB and AC. Label each side with its length.

Skills You’ll Need 247

6 cm

7 cm
4 cm

B

A

C

6 cm

7 cm
4 cm

B

A

C

Gr7 Math/U7/F1  7/21/04  8:07 AM  Page 247



248 UNIT 7: Geometry

Example 2

Construct �BCD with BC � 6 cm, �B � 110°, and �C � 30°.

Solution

You will need a ruler and protractor.

Step 1 Sketch the triangle.

Step 2 Construct the triangle:

Use a ruler to draw side BC � 6 cm.

Use a protractor to make an angle of 110° at B.

Use a protractor to make an angle of 30° at C.

Label point D where the arms of the angles intersect.

Label the known side and angles.

5. Construct each triangle.

a) �CDE with CD � 4 cm, DE � 7 cm, CE � 9 cm

b) �DEF with DE � 7 cm, �D � 80°, �E � 30°

✓

6 cm
B

D

C
110° 30°

6 cm

B

D

C

110° 30°
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Plotting Points on a Coordinate Grid

When we draw a horizontal axis and a vertical axis on grid paper,

we have a coordinate grid.

The axes intersect at the origin, O.

We label each axis with numbers, beginning with 0 at the origin.

A point on a grid is described by its coordinates.

Point A has coordinates (4, 6).

To plot point A, start at 4 on the horizontal axis, then move up 6 spaces.

Mark a point. This is point A.

Point B has coordinates (0, 3).

To plot point B, start at 0, then move up 3 spaces. Point B is on the vertical axis.

Point C has coordinates (6, 0).

To plot point C, mark a point at 6 on the horizontal axis.

6. On grid paper, draw a coordinate grid.

Plot each point on the grid.

A(5, 7), B(3, 8), C(10, 4), D(9, 1), E(0, 8), F(5, 0)

7. a) Where are all the points with horizontal coordinate 0?

b) Where are all the points with vertical coordinate 0?

10 2 3 4 5

C (6, 0)

B (0, 3)

A (4, 6)

6 7

1

2

3

4

5

6

7

horizontal axis

ve
rt

ic
al

 a
xi

s

O
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Look around the classroom.

Name the different figures you see.

Which figure is most common?

Work with a group.

You will need a ruler and a protractor.

Your teacher will give you a large copy of these figures.

➢ Identify each figure.

Describe it.

➢ Choose two figures.

How many different ways can you compare them?

➢ Choose three figures. How are they the same? 

How are they different?

Reflect & Share

Share your results with another group of classmates.

Work together to classify the figures in different ways.

250 UNIT 7: Geometry

7.1 Classifying Figures

Identify, describe, and classify
geometric figures.

Focus

E F
G

H
I

DC
B

A
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Example 

7.1 Classifying Figures 251

A polygon is a closed figure with sides that are line segments.

Exactly 2 sides meet at a vertex.

The sides intersect only at the vertices.

This figure is a polygon. These figures are not polygons.

A regular polygon has all sides equal and all angles equal.

These polygons are regular.

A convex polygon has all angles less than 180°.

These polygons are convex.

A concave polygon has at least one angle greater than 180°.

These polygons are concave.

Here is a regular hexagon.

a) How many lines of

symmetry does it have?

b) What is the rotational symmetry?

A regular polygon has
line symmetry and
rotational symmetry.

Recall that matching
arcs or symbols in
angles show that the
angles are equal.

Gr7 Math/U7/F1  7/21/04  8:07 AM  Page 251



Solution

S S

252 UNIT 7: Geometry

a) Trace the hexagon.

Fold the tracing paper so that one part of the 

hexagon coincides with the other.

The fold line is a line of symmetry.

Repeat the folding as many times as possible.

A regular hexagon has 6 lines of symmetry:

3 lines join opposite vertices, and 3 lines

join the midpoints of opposite sides.

b) Trace the hexagon. Place the tracing 

to coincide with the hexagon.

Rotate the tracing about its centre until

the tracing coincides with the hexagon again.

Count how many times you can do this.

The tracing coincides with the hexagon 6 times.

So, a regular hexagon has rotational symmetry of order 6.

1. Explain why each figure is not a polygon.

a) b)

2. a) Is each polygon regular? How do you know?

i) ii) iii) 

b) Which polygons in part a have:

i) line symmetry? ii) rotational symmetry?

How do you know?

Label two corresponding
vertices. Then you know
when the tracing is back
at the starting position.
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3. Identify the figures in each flag.

Describe each figure as many ways as you can.

a) Congo     b) Bosnia-Herzegovina c) Guyana    d) Seychelles

4. Describe each figure. How are the figures the same? Different?

a) b) c) 

5. Match each polygon with its description below.

a) an isosceles triangle with an angle of 40°

b) a rhombus with a right angle

c) a pentagon with an angle of 120°

d) a parallelogram with an angle of 60°

e) an obtuse triangle with an angle of 110°

6. Use square dot paper or isometric dot paper.

Draw each polygon.

a) an isosceles triangle with a height of 4 units

b) a parallelogram with an angle of 45°

c) a trapezoid with a 90° angle and a 45° angle

d) a kite with exactly one right angle

e) a parallelogram with a 90° angle

f) a scalene obtuse triangle 

g) an isosceles right triangle

h) a hexagon with exactly 3 right angles

7. Identify each polygon.

Describe it as many ways as you can.

7.1 Classifying Figures 253

A
B C

B E

A B
C

D
E

A
C D
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8. Use dot paper.

a) Draw a quadrilateral. Label it A.

b) Draw another quadrilateral that differs from quadrilateral A 

in only one way. Label it B.

c) Continue to draw quadrilaterals that differ in only one way.

Label each one you draw.

How many different quadrilaterals can you draw?

9. Assessment Focus
The 3 points A, B, C are vertices of a polygon.

Copy the points on dot paper.

a) Find other vertices and sketch each figure.

i) a trapezoid with line symmetry

ii) a kite

iii) a parallelogram

iv) a pentagon

b) How many other figures can you 

make that have these points as 3 vertices?

Identify each figure. Describe it as many ways as you can.

10. The lengths of three sides of a quadrilateral are 5 cm, 5 cm,

and 8 cm.

a) Sketch and name the different quadrilaterals possible.

b) Suppose one angle is 90°. Which quadrilaterals are possible 

now? Justify your answer.

Choose 3 different polygons. Sketch each polygon as many different

ways as you can. Describe each polygon.

254 UNIT 7: Geometry

A quadrilateral is a
polygon with 4 sides.

Your World

The Department of Highways uses different
figures for road signs. Which road signs use
each of these figures: pentagon, octagon,
square, circle, rectangle, triangle?

Find the next 3 numbers 
in each pattern.

What is each 
pattern rule?

• 23, 28, 26, 31, 29,…

• 6, 9, 15, 27, 51,…

• 1, 3, 9, 27,…

Number Strategies

A

B

C
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Work on your own.

You will need a ruler, protractor, and compass.

For each set of measurements given, how many different triangles

can you draw?

➢ Construct a triangle with sides of length 5 cm, 7 cm, and 9 cm.

➢ Construct a triangle with two sides of length 9 cm and 5 cm, and 

one angle of 30°.

➢ Construct a triangle with one side of length 5 cm and two angles 

of 40° and 60°.

Reflect & Share

Compare your triangles with those of several classmates.

➢ How many different triangles can you draw in each case?

- when you know 3 sides

- when you know 2 sides and 1 angle

- when you know 1 side and 2 angles

➢ What measurements do you need to know to be able to draw 

exactly one triangle?

➢ When 3 sides of a triangle are given, only one triangle can be 

drawn. So, if we know that two triangles have the same 3 sides,

those triangles must be congruent.

We say: Triangle ABC is congruent to triangle EDF.

We write: �ABC � �EDF

7.2 Congruent Figures 255

7.2 Congruent Figures

Identify the conditions for congruence.Focus

Congruent figures have
the same size and shape.
These triangles are
drawn to scale.

8 cm

6 cm5 cm

A

B C
8 cm

6 cm5 cm

E

D F
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Example 

�ABC and �EDF have:

corresponding sides equal          and         corresponding angles equal

AB � ED �A � �E

BC � DF �B � �D

AC � EF �C � �F

➢ When 2 sides and 1 angle of a triangle are given,

there are two cases to consider.

• The given angle is between the 2 sides.

Only one triangle can be drawn.

So, triangle GHJ is congruent to triangle LKM or

�GHJ � �LKM

• The given angle is not between the 2 sides.

Sometimes more than one triangle can be drawn.

�PQR and �STU are not congruent.

➢ When 2 angles and 1 side 

are given, only one triangle 

can be drawn.

�BCD � �FGE

Are the figures in each pair congruent? How do you know?

a)

We list the corresponding
vertices of the triangles
in the same order.

You may have to flip or
rotate one triangle so
both triangles face the
same way.

P S

Q R T U

5 cm
5 cm

6 cm 6 cm

40°
40°

B

C D
8 cm

60° 50°

F

G E
8 cm

60° 50°

6 cm

5 cm

H K

G J
6 cm

5 cm

M L
40° 40°

A

C

E F

D

10 cm

10 cm

B

30°

70°

70° 30°

256 UNIT 7: Geometry
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7.2 Congruent Figures 257

Solution

b)

a) �ABC and �FED have 2 pairs of corresponding angles equal 

and 1 pair of corresponding sides equal:

�A � �F � 30°

�B � �E � 70°

AB � FE � 10 cm

So, �ABC and �FED are congruent: �ABC � �FED

b) Quadrilateral ABCD and quadrilateral EFGH have 4 pairs of

corresponding sides equal. But the quadrilaterals have different 

shapes. So, the quadrilaterals are not congruent.

Part b of the Example shows that for two quadrilaterals to be

congruent, it is not sufficient that 4 pairs of corresponding sides are

equal. We need to know that the corresponding angles are equal, too.

1. Look at the triangles below.

Find pairs of congruent triangles.

Explain why they are congruent.

8 cm

3 cm

6 cm
5 cm

H G

E

F

CD

A B

6 cm 5 cm

3 cm

8 cm

4 cm

4 cm

4 cm

4 cm

A

H

50°

50°

50°

50°

B

C

N

M

G

E

D

F

J

L

40°

40°
40°

40°
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2. Are quadrilaterals ABCD and KLMN congruent? 

How do you know?

3. In each figure below, name pairs of congruent triangles.

Explain how you know they are congruent.

Try to find more than one way to show 

the triangles are congruent.

a) ABCD is a kite. b) PQRS is a parallelogram.

c) EFGH is a rhombus. d) JKLM is a rectangle.

4. For each figure below:

a) Sketch the figure.

b) What are the fewest measurements you need to know to draw 

the figure?

c) How does your answer to part b help you identify congruent 

figures of this type?

i) parallelogram ii) rectangle iii) square

5. �ABC and �DEF have AB � DE � 6 cm and 

BC � EF � 7 cm.

a) Sketch the triangles.

b) What else do you need to know to tell if

the triangles are congruent?

258 UNIT 7: Geometry

When you name congruent
triangles, remember to list
corresponding vertices in
the same order.

A

D

C

B

S
R

Q
P

L

M

J

K

4 cm

4 cm

2 cm

2 cm

B
N K

M L

C

D

A

110°

70°

110°

70°

FE

GH
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6. Assessment Focus    Use dot paper.

a) Draw two quadrilaterals with equal sides, but the 

quadrilaterals are not congruent.

Explain why the quadrilaterals are not congruent.

b) Use the 4 side lengths in part a. Draw two congruent 

quadrilaterals with these side lengths.

Explain how you know the quadrilaterals are congruent.

c) Explain how the quadrilaterals in parts a and b are different.

7. Alex called a carpet store.

He wanted a piece of

carpet to repair a 

damaged rug.

Alex asked for a piece 

measuring 3 m by 4 m 

by 5 m by 6 m.

Explain why the 

salesperson could not 

help Alex.

8. a) Are all isosceles triangles with two 50° angles congruent? 

Explain.

b) Are all isosceles triangles with two 50° angles and exactly one 

side of length 10 cm congruent? Explain.

9. Construct a right triangle with one side 5 cm and 

the longest side 8 cm.

a) Can you draw two different triangles with those 

measurements? 

b) If your answer to part a is yes, draw the triangles.

c) If your answer to part a is no, explain how you know that only

one triangle can be drawn with these measurements.

Describe the different ways you can tell if

two triangles are congruent.

7.2 Congruent Figures 259

Take It Further

Mental Math

Which three
factors of 24 have
a sum of 20?
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260 UNIT 7: Geometry

1. Identify each figure.

a) a scalene triangle with 

an angle of 50°

b) an isosceles triangle with 

an angle of 50°

c) a right triangle with 

an angle of 50°

d) an obtuse triangle with 

an angle of 50°

e) an acute triangle with 

an angle of 50°

2. Use dot paper.

a) Draw 2 congruent concave 

hexagons. How do you know the 

hexagons are congruent? How do 

you know they are concave?

b) Draw 2 congruent convex 

hexagons. How do you know the 

hexagons are convex? How do 

you know they are congruent?

3. Segment AB is one side of �ABC.

Use dot paper.

a) Draw �ABC.

b) Draw a triangle congruent 

to �ABC. How do you know 

the triangles are congruent?

c) Draw a triangle that is not

congruent to �ABC.

How do you know the triangles 

are not congruent?

4. Use these figures.

a) Identify 2 figures that are not

congruent. How do you know 

they are not congruent?

b) Identify 2 congruent figures. How

do you know they are congruent?

LESSON

7.1

7.1

7.2

7.2

A

B
G

H

J

C

F

D

E

110°

20°

40°

50°50°

50°

80°

50°

A B

A D

C

B

J

M

L

K

F

P

N

Q

R

G

H

E

4.5 cm

3 cm

3 cm

6 cm

2 cm
2 cm

4 cm

2 cm

2 cm

3 cm

4 cm

3 cm

3 cm 2 cm

2 cm
4 cm
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7.3 Transformations 261

7.3 Transformations

Recognize transformation images.Focus

Work with a partner.

Your teacher will give you a large copy of these figures.

The shaded figure has been translated, rotated, and reflected.

Each labelled figure is the image after a transformation.

Identify the transformation that produced each image.

Explain how you know.

Reflect & Share

Discuss your strategies for identifying each transformation.

What is special about a reflection image? A translation image? 

A rotation image?

Use tracing paper and a
Mira if they help. F

B

A

CD

E
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262 UNIT 7: Geometry

We can show transformations on a grid.

Translation

The shaded figure is translated 

5 units right and 3 units up.

Its translation image is figure A.

The translation arrow shows the 

movement in a straight line.

Reflection
The shaded figure is reflected in a 

horizontal line 1 unit below the 

figure. Its reflection image is 

figure B.

The figures have different 

orientations. That is, you flip

one figure to make it coincide

with the other figure.

Rotation

The shaded figure is rotated a
�
1
4� turn clockwise. The turn centre

is the vertex indicated.

The rotation image is figure C.

We get the same image if the 

shaded figure is rotated a �
3
4� turn 

counterclockwise about the 

turn centre.

Here are the three images 

and the shaded figure 

on the same grid.

The translation image
and the shaded figure
are congruent.

The reflection image
and the shaded figure
are congruent.

The rotation image
and the shaded
figure are congruent.

Mirror 
line

B

C

Turn centre

1
4

turn  
clockwise

C 3
4

turn  
counterclockwise

C

A

B

A

Translation
arrow

5 3
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7.3 Transformations 263

We can show transformations on a coordinate grid.

Use tracing paper to
verify the image.

Use a Mira to verify
the image.

Solution 3

Solution 1

Example 

Solution

Look at these rectangles.

Is one rectangle a 

transformation image 

of the other? Explain.

Let the blue rectangle be the original figure.

And let the red rectangle be the image.

The red rectangle is the 

image after a translation 

of 3 units right. The 

translation arrow shows 

the movement.

The red rectangle is the 

image after a reflection 

in a vertical line through (3, 0) 

on the horizontal axis.

The red rectangle is the 

image after a rotation of

a �
1
2� turn about the point 

with coordinates (3, 3).

The Example shows that an image may be the result of any one of

the 3 transformations.

It also shows a rotation about a turn centre that is not on the figure.

Solution 2
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1. Use the figures below.

Identify the transformation for which:

a) Figure B is the image of Figure A.

b) Figure C is the image of Figure A.

c) Figure E is the image of Figure B.

d) Figure A is the image of Figure D.

e) Figure C is the image of Figure D.

2. Identify each transformation.

a) Figure A is the image of Figure B.

b) Figure B is the image of Figure C.

c) Figure C is the image of Figure D.

d) Figure D is the image of Figure A.

3. Draw this flag on a coordinate grid. The coordinates are 

A(11, 11), B(11, 13), C(11, 15), and D(12, 14).

Draw the image of the flag after each transformation.

a) a translation 3 units right

b) a translation 5 units down

c) a reflection in a vertical line through (9, 0) 

d) a reflection in a horizontal line through (0, 8) 

e) a rotation of a �
1
2� turn about point A

f) a rotation of a �
1
4� turn clockwise about point C

264 UNIT 7: Geometry

Number Strategies

Add or subtract,
as indicated.

• �
5
8� � �

7
6�

• �
1
1
7
0� � �

3
4�

• �
1
1
1
2� � �

2
3�

• �
4
5� � �

5
6�

C

A

B E

D

B
A

D C

A

B

C
D
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7.3 Transformations 265

4. How many different ways can each figure be described 

as a transformation of another figure? Explain.

5. a) Which pairs of congruent figures do not represent a figure 

and its transformation image? How do you know?

b) For each pair of congruent figures that do show a 

transformation, identify the transformation.

6. Assessment Focus Use grid paper.

In each case, describe the figure you drew.

a) Draw a figure for which a translation image is also a reflection

image and a rotation image. Draw the translation image.

b) Draw a figure for which a translation image is also a reflection

image, but not a rotation image. Draw the translation image.

c) Draw a figure for which a translation image is not a reflection 

image nor a rotation image. Draw the translation image.

7. Describe Figure A as a transformation 

image of Figure B as many 

different ways as possible.

When you see a figure and its transformation image on a grid,

how do you identify the transformation? 

Use diagrams in your explanation.

Take It Further

A
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266 UNIT 7: Geometry

Work on your own.

You will need index cards, a ruler, and scissors.

➢ Draw a triangle on a card. Cut it out.

Use tracings of the triangle to cover a piece of paper.

➢ Draw a quadrilateral on a card. Cut it out.

Use tracings of the quadrilateral to cover a piece of paper.

➢ Draw a pentagon on a card. Cut it out.

Use tracings of the pentagon to cover a piece of paper.

Reflect & Share

Share your results with the class.

• Will congruent triangles cover a page and leave no gaps? Explain.

• Will congruent quadrilaterals cover a page and leave no gaps? 

Explain.

• Will congruent pentagons cover a page and leave no gaps? 

Explain.

How can you tell if congruent figures will cover a page 

and leave no gaps?

When congruent copies of a figure cover a page and leave no gaps,

we say the figure tiles the plane.

➢ A triangle always tiles the plane.

You can rotate or flip the
figure to try to make it fit.

At any point where
vertices meet, the
angles add to 360°.

7.4 Tiling Patterns

Construct and analyse tiling patterns.Focus

360°
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7.4 Tiling Patterns 267

Example 

Solution

➢ A quadrilateral always tiles the plane.

Will a pentagon always tile the plane? Explain.

If we can find a pentagon that does not tile the plane,

we can say that a pentagon does not always tile the plane.

Draw a regular pentagon.

Use tracing paper to repeat the pentagon to try to cover the page.

This pentagon does not cover the page.

It leaves gaps that are rhombuses.

Five vertices do not meet.

There are points where 3 vertices meet and 

the sum of the angles is less than 360°.

There are points where 2 vertices meet and 

the sum of the angles is less than 360°.

So, a pentagon does not always tile the plane.

In the Practice questions, you will investigate to find which other

figures do tile the plane.

At any point where
vertices meet, the
angles add to 360°.

360°
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1. Use dot paper.

Draw a convex hexagon that is not regular.

Try to cover the dot paper with copies of this hexagon.

Does the hexagon tile the plane? Explain.

2. Use dot paper.

Draw a concave hexagon.

Try to cover the dot paper with copies of this hexagon.

Does the hexagon tile the plane? Explain.

3. Here is a regular octagon.

Trace this octagon.

Try to tile the plane.

What do you notice?

4. Look at the picture called Reptiles, drawn by M.C. Escher.

Which figure do you think Escher started with?

Explain how Escher’s reptiles tile the plane.

268 UNIT 7: Geometry
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5. A floor tile is a regular hexagon.

What happens when you try to tile a rectangular floor 

with a regular hexagon?

Use isometric dot paper to find out.

6. Why do most tiling patterns in floors and patios use 

squares or rectangles?

7. Assessment Focus
Not all pentagons tile the plane. Use grid paper.

a) Find a pentagon that will tile the plane.

Describe the pentagon.

Explain how it tiles the plane.

b) How many different pentagons can you find that will tile the 

plane? Draw each pentagon and show how it tiles the plane.

c) Explain why some pentagons tile the plane, while others 

do not.

8. In question 3, you discovered that a regular octagon 

will not tile the plane.

Use grid paper. Find an octagon that will tile the plane.

Explain how it tiles the plane.

9. Think about “tiling” in nature. Which figures are used?

How can you tell if a polygon will tile the plane? 

Use examples in your explanation.

Calculator Skills

Evaluate.

• 23.56 � 27.39 � 4.35

• (23.56 � 27.39) � 4.35

Why are the answers
different?

Take It Further
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Work on your own.

You will need isometric dot paper.

Choose two or more of these Pattern Blocks.

Make a design to cover a page.

Copy your design on dot paper.

Label each figure in your design.

Explain your design in terms of transformation images.

That is, how do you rotate, translate, or reflect each Pattern Block to

generate the design? Write your instructions carefully.

Reflect & Share

Trade instructions with a classmate.

Generate your classmate’s pattern.

Check your version of the pattern with your classmate’s.

How do they compare?

In Section 7.4, you investigated tiling patterns.

You used congruent copies of one figure.

You discovered that not all octagons tile the plane.

But an octagon and a square can tile the plane,

as shown in the Example that follows.

7.5 Using Transformations to Make Designs

Create and analyse designs 
using transformations.

Focus
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Example 

Solution

Use transformations to describe how to construct this design.

Label the figures in the design, as shown.

Start with the shaded octagon.

To get octagon A, rotate the 

shaded octagon a �
1
2� turn about a 

turn centre that is at the midpoint 

of the right side.

Repeat a similar rotation to get figure B from figure A.

To get octagon D, rotate the 

shaded octagon a �
1
2� turn about a 

turn centre that is at the midpoint 

of the bottom side.

Repeat a similar rotation to get octagon E from octagon A.

Look at the shaded square.

To get square J, rotate the shaded 

square a �
1
2� turn about the midpoint 

of the top side of octagon A.

Repeat a similar rotation to get square K from square J.

Step 1

Step 3

Step 2

A B C

E

L M N

J K

D F G

A

D

A

J
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272 UNIT 7: Geometry

To get square L, rotate the 

shaded square a �
1
2� turn about the 

midpoint of the left side of

octagon A.

Repeat a similar rotation to get square M from square J.

1. Here is the design from the Example.

a) Use translations to describe how to construct this design.

b) Use reflections to describe how to construct this design.

2. Use this figure and transformations to create a design 

on grid paper.

Describe the design in terms of transformations.

3. Use isometric paper. Use a parallelogram and an equilateral 

triangle to make a design.

Use transformations to describe the design.

4. Draw a figure. Use transformations of the figure to make a 

border design for a photo frame.

Draw the design. Describe how you made it.

Step 4

Number Strategies

Which number is
the least?

• the sum of all the
factors of 30

• the sum of all the
factors of 46

• the product of all 
the factors of 67

A

L
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5. The Alhambra is a walled city 

and fortress in Granada, Spain.

It was built in the 14th century.

Here is part of one of its 

many tiling patterns.

Copy this pattern on dot paper.

Continue the pattern to cover the page.

Use transformations to describe the pattern.

6. Assessment Focus
Use dot paper or grid paper.

Create a design that uses 2 or more figures 

that together tile the plane.

Colour your design.

Use transformations to describe your design.

Try to describe your design as many ways as you can.

7. Here is a flooring pattern.

Use a copy of this pattern.

Use transformations to describe the patterns in one square.

When you use transformations to describe a design,

how do you decide which transformation to use? 

Include a design in your explanation.
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Software, such as The Geometer’s Sketchpad, can be used to

transform figures.

Follow these steps:

1. Open The Geometer’s Sketchpad.

From the File menu, choose New Sketch.

To make a “grid paper” screen:

2. From the Edit menu, click on Preferences.

Select the Units tab.

Check that the Distance Units are cm.

Click OK.

3. From the Graph menu, choose Define Coordinate System.

The screen has grid lines and two numbered axes.

4. Click on each axis and the two red dots.

The axes and the dots are highlighted.

From the Display menu, choose Hide Objects.

The axes and dots disappear.

The screen appears like a piece of grid paper.

5. From the Graph menu, choose Snap Points.

Translating a Figure

6. To create a quadrilateral:

From the Toolbox, choose        .

Click and drag to construct 

a quadrilateral.

7. To translate the quadrilateral:

From the Toolbox, choose        .

Click each side of the 

quadrilateral to select it.

The quadrilateral is highlighted.

Use technology to create and
analyse designs.

Focus

Using a Computer to  
Transform Figures
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8. From the Transform menu, choose Translate.

Under Translation Vector:, choose Rectangular.

Under Horizontal:, choose Fixed Distance.

Enter 2.0 cm for the Horizontal distance.

Under Vertical:, choose Fixed Distance.

Enter 2.0 cm for the Vertical distance (below left).

Click Translate to get the quadrilateral and its image

after a translation 2 right, 2 up (below right).

9. Drag any vertex or side of the original figure.

See what happens to the translation image.

10. From the Edit menu, choose Undo Translate Point.
The screen shows the original quadrilateral and translation 

image.

To print the quadrilateral and its translation image,

from the File menu, choose Print.

11. Repeat Steps 7 to 10 using different horizontal 

and vertical distances.

Rotating a Figure

12. From the File menu, choose New Sketch.

Follow Steps 2 to 5 to make a “grid paper” screen.

13. To create a triangle:

From the Toolbox, choose        .

Click and drag to construct a triangle.

14. To rotate the triangle:

From the Toolbox, choose        .

Click to place a point near the triangle.
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276 UNIT 7: Geometry

15. Click to select the point.

From the Transform menu, choose Mark Center.

This is the turn centre for your rotation.

16. From the Toolbox, choose        .

Click to select each side of the triangle.

The triangle is highlighted.

17. From the Transform menu, choose Rotate.

Under Rotate By:, choose Fixed Angle.

Enter 90 degrees. Click Rotate to show the triangle and its 

image after a rotation of 90° counterclockwise.

18. Drag any vertex or side of the original figure.

See what happens to the rotation image.

19. From the Edit menu, choose Undo Translate Point.
The screen shows the original triangle and rotation image.

20. Repeat Steps 16 to 19 using a different number of degrees 

of rotation. Print the figure and its rotation image.

Reflecting a Figure

21. Repeat Step 12.

22. To create a polygon:

From the Toolbox, choose      .

Click and drag to construct a polygon.

23. To reflect the polygon:

With the Straightedge Tool still selected, draw a vertical 

line near your polygon. The line is highlighted.
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24. From the Transform menu, choose Mark Mirror.
The line is a mirror line.

25. From the Toolbox, choose        .

Click to select each side of the polygon.

The polygon is highlighted.

26. From the Transform menu, choose Reflect.
The polygon and its reflection image are shown.

27. Drag any vertex or side of the original figure.

See what happens to the reflection image.

28. Drag either end point from the mirror line.

See what happens.

29. From the Edit menu, choose Undo Translate Point.
Do this two times. The screen shows the original polygon 

and its reflection image.

30. Repeat Steps 23 to 28 using a horizontal mirror line.

Print the figure and its reflection image.

Use any or all of the transformations above to make a design that

covers the screen.

Print your design.

✓

Gr7 Math/U7/F1  7/21/04  8:19 AM  Page 277



Choosing a Strategy

278 UNIT 7: Geometry

Remember to 
count squares of
different sizes.

Strategies

•  Make a table.

•  Use a model.

•  Draw a diagram.

•  Solve a simpler 
problem.

•  Work backward.

•  Guess and check.

•  Make an 
organized list.

•  Use a pattern.

•  Draw a graph.

•  Use logical 
reasoning.

1. A train is travelling at a rate of 1 km every 45 s.

At this rate, how far will the train travel in 1 h?

2. How many squares are 

in this rectangle?

3. Use grid paper. Try to draw a quadrilateral with each number of

lines of symmetry.

a) 0 b) 1 c) 2

d) 3 e) 4 f) 5

Which quadrilaterals could you not draw? Explain.

4. Use grid paper. Draw this figure:

It has at least 1 line of symmetry.

It has perimeter 24 units.

It has area 23 square units.

5. Copy the diagram below.

Write these numbers in the boxes: �
1
6�, �

1
3�, �

1
2�, �

2
3�, �

5
6�, 1;

so the sum of the fractions along each side is :

a) 1�
1
2� b) 2

6. What fraction of the area of

a tangram is triangles?

7. Write the next five terms in each pattern.

Describe each pattern rule.

a) �AB C D
E F

�

b) 1, 5, 10, 25, …

c) O, T, T, F, F, S, S, …
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Using linking cubes to
build the prism.

8. This rectangular prism is made with 12 

different coloured cubes. The colours are 

black, white, red, orange, light green, dark 

green, light blue, dark blue, brown, yellow,

pink, and purple.

a) The colours on the left face are light green, orange,

brown, and red.

Draw and colour the back face of the prism.

Another congruent prism is made from the coloured 

cubes. The colours on the front face are: red, orange,

dark green, light blue, black, and white.

The colours on the top face are: red, black, white, pink,

purple, and yellow.

The colours on the right face side are: light blue, white,

yellow, and brown.

The colours on the left face side are: red, dark green,

pink, and dark blue.

b) Build the prism. Sketch the prism.

c) What colours are on the bottom face of the prism?

How do you know?

9. In her fitness program Jessie runs on Mondays,

Wednesdays, and Saturdays, and swims on Tuesdays and 

Fridays. Malcolm runs every third day and swims on the 

day after each run.

Jessie and Malcolm run together on Saturday July 6.

On what days and dates in July will they:

a) run together again?

b) swim together?
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An office space planner plans the best use of the office space.

He ensures that employees have a workplace that is functional and

attractive. Systems furniture is a series of connected partitions, work

surfaces, and cabinets. It is frequently used in offices. The planner

uses a computer to design multiple ‘standard’ work areas. Each work

area is designed to meet the needs of a group of employees with

similar jobs. The work areas are also designed to ‘fit’ with other work

areas of the same size and shape, and with work areas that have

different sizes and shapes. It’s all a bit of a puzzle! The space planner

must solve the puzzle using geometry and an understanding of how

people work and interact (ergonomics).

A workplace, where every work area or ‘cubicle’ is identical, is often

seen as ‘cell-like’ or dehumanizing. Suppose you are an office

planner. What might you do to make groups of work areas more

appealing, and still make the best use of the available floor area?

Office Space Planner
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What Do I Need to Know?

✓ Conditions for Congruent Triangles 
Two triangles are congruent if:

• three pairs of corresponding sides are equal

• two pairs of corresponding sides are equal and the corresponding 

angles between these sides are equal

• two pairs of corresponding angles are equal and one pair of

corresponding sides are equal

✓ Conditions for Congruent Figures
For figures that are not triangles, two figures are congruent if corresponding 

sides are equal and corresponding angles are equal.

2.5 cm

3.5 cm 3.5 cm

2.5 cm

50° 50°

3.0 cm

35°

105°

Review any lesson with

3.0 cm

2.5 cm

5.0 cm

3.0 cm

2.5 cm

5.0 cm

3.0 cm

35°

105°

Gr7 Math/U7/F1  7/21/04  8:20 AM  Page 281



E

D
2 cm

2 cm
3 cm

3 cm

4 cm
4 cm

F

C

B

A

282 UNIT 7: Geometry

1. Use grid paper or dot paper.

Draw each figure.

a) a concave hexagon

b) a convex pentagon

c) a concave quadrilateral

d) a figure that is not a polygon

e) a regular triangle

Describe the attributes of each 

figure. Include angle measures.

2. Use grid paper or dot paper.

Draw each figure.

a) a hexagon with exactly 2 lines 

of symmetry 

b) a triangle with rotational 

symmetry of order 3

c) a pentagon with exactly 

3 acute angles

d) a pentagon with exactly 

3 obtuse angles

Describe the attributes of each 

figure. Include angle measures.

3. Are the figures in each pair 

congruent? How do you know?

a)

b)

4. Plot these points on a 

coordinate grid:

A(4, 6), B(4, 7), C(7, 9), and 

D(6, 6).

Join the points to form a 

quadrilateral.

The coordinates of the vertices of

3 images are given.

Identify the transformation that 

produced each image.

a) C(7, 9), E(5, 12), F(4, 12),

G(4, 10)

b) I(4, 16), J(6, 16), K(7, 13),

L(4, 15)

c) M(9, 4), N(8, 1), P(6, 1),

Q(6, 2)

5. Copy this figure on grid paper.

How many different ways can you

use the figure to tile the plane?

Show each way you find.

6. Draw 2 different figures on 

grid paper that will together 

tile the plane.

Use the figures to make a design.

Colour one of each figure.

Use transformations to explain 

how to create the design 

beginning with each 

coloured figure.

LESSON

7.2

7.3

7.4

What Should I Be Able to Do?

7.1

7.5

For extra practice, go to page 444.

E

A

D

C

F

G

H

I

J

B
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1. Use the figures below.

Identify:

a) two congruent figures, and explain how you know 

they are congruent

b) two figures that are not congruent, and explain how you know 

they are not congruent

c) a scalene triangle with a 60° angle

d) a quadrilateral with a 60° angle

2. Two triangles are congruent if they have 3 matching sides. Suppose 

two triangles have 3 matching angles. Are the triangles congruent? 

Justify your answer.

3. Three students looked at a figure and its transformation image.

Igal said the picture showed a translation.

Shaian said the picture showed a rotation.

Cherie said the picture showed a reflection.

All three students were correct. What might the picture be? 

Draw a diagram to show your thinking.

4. Julie will use both of these tiles to cover her floor.

Use isometric paper.

Draw 2 different designs Julie could use.

For each design, use transformations to explain how to 

create the design.

10 cm 10 cm

4.5 cm

2.5 cm

2.5 cm

2.5 cm

2.5 cm

2.0 cm

2.0 cm4.5 cm

4.5 cm

3.0 cm

4.0 cm

N

P
C

B

A

E F

G
M

K

J

H

D

Q

6.0 cm

60°

60°

60° 73°

47°

60°

60°

60°
120°

120°

120°
120°

73°

47°
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Tessellations

When we tile the plane with congruent copies of one figure,

we make a tessellation.

M.C. Escher was a famous Dutch artist.

He designed many different tessellations.

You will create two designs in the Escher style.

The first design is in the style of Reptiles, on page 268.

Part 1

Use square dot paper or grid paper.

Tile the plane with a figure of your choice.

Sketch a design on one figure.

Repeat the sketch until every figure in the plane has the design.

Use transformations to describe how to generate the design

beginning with one tile.

Unit Problem
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How are transformations related to congruent figures? 

Include diagrams in your explanation.

Your work 
should show:

the initial tile you 
created for each 
design

the designs 
you created

how you used 
transformations to 
create the designs

the correct use of 
mathematical 
language

You could start with 
a rectangle, parallelogram,
or regular hexagon,
instead.

set up of kid looking through escher
book G7-7UP2 and doing activity

✓

✓

✓

✓

Part 2
Start with a square. Draw congruent curves on 2 sides.

A curve that goes “in” on one side must go “out” on the other side.

Draw different congruent curves on the other 2 sides.

Trace the new figure on cardboard.

Cut out the figure.

Use it to tile the plane.

Add details to your tile 

so it represents an 

animal or an object 

of your choice.

Check List
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